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Introduction 

Welcome to the CEN Amendment Simple Template Quick Start Guide!  

This document will provide a comprehensive overview of the CEN Amendment Simple Template, and 
how to use the Template to draft an amendment quickly and efficiently. This document is 
supplementary to the content found on the CEN BOSS website.  

Happy drafting! 
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1 Getting Started 

You have downloaded the CEN Amendment Simple Template from the CEN BOSS – now what?  

The Amendment Simple Template contains all the applicable styles needed to provide an XML file. At 
present, CEN Editors have the obligation to provide an XML file as part of the standards deliverable 
package for 100 % of applicable deliverables – this includes Amendments. This is why the Amendment 
Simple Template is an indispensable tool for all involved!   

The template itself is easy to use. Throughout the template, you will see there are portions of red and 
blue text. The red text is text that should be edited accordingly in each document (e.g. in Clause 2). The 
blue text is a note to the drafter and shall therefore be deleted prior to submission. 

The template is a flat Word document, so editing it according to your needs is easy, provided you have 
access to Word. Simply open the template as normal, and you're ready to start drafting! Just type 
straight into the template! 

All obligatory components are found in the Amendment Simple Template, clearly defined for your 
convenience. In addition, the updated rules from the Internal Regulations Part 3 are applied, too, but 
further information on those can be found on the CEN BOSS.   
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2 Using the template 

2.1 General 

The Amendment Simple Template is a flat Word document designed to be drafted straight into.  

The structure given in the template is a guide, so you will need to pick the elements which apply to your 
amendment text. This means you'll need to apply a number of different styles, all of which are found 
within the template.   

It is advised that you draft with the paragraph markers  visible (although this is not obligatory).  

For CEN deliverables, the font is Cambria, and the size for plain body text is 11 pt. 

2.2 Styling Palette 

The styling palette is handy to have open during the drafting process. The palette gives you access to 
every style found in the document. Each style is clearly named so you can choose which style you need 
without too much hassle.  

To open the styling palette, select the 'Home' tab from the ribbon across the top of Word, and go to the 
'Styles' section. Click the small arrow highlighted in Figure 1.  

 

Figure 1  Opening the Styling Palette 

The styling palette is shown in Figure 2.  
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Figure 2  The Styling Palette 

The palette is a separate window which you can move around, resize as desired, and fully scrollable. 

2.3 How to see applied styles 

When applying the styles, it's always best to use the draft view, rather than the default print view. The 
draft view allows you to see each style in a left-hand-side pane, allowing you to apply the styles quickly 
and easily.  

The draft view is found under the 'View' tab across the top ribbon, in the first section (see Figure 3). 
Alternatively, the keyboard shortcut 'Ctrl+Alt+n' can be used. For a comprehensive list of useful 
keyboard shortcuts, see Annex B.  

 

Figure 3  Finding the Draft View 
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When you're in the draft view, if you do not see a style pane on the left-hand-side, you need to adjust 
your settings. To do this, open up the settings in Word using 'File' and then 'Options'. This will open a 
pop-up window shown in Figure 4. Under the 'Advanced' tab, scroll down to 'Display'.  

 

Figure 4  Setting the Styling Pane 

The row 'Style area pane width in Draft and Outline Views' needs to be set at around 3 cm (1 inch). The 
pane can then be dragged to the right to increase the size, if needed.  

2.4 Applying styles throughout the document  

Applying styles is straightforward – a simple 'point and click'. Once the palette is open, you can simply 
highlight or click on the text you wish to style and click the chosen style in the palette.  

If you want to apply a single style to a number of different paragraphs through the text, but these 
paragraphs are in different clauses, you can use the format painter tool, too. If you don't want to click, or 
you prefer keyboard shortcuts, styles can be copy-pasted.  

To copy a style, highlight the text and press 'Ctrl+Alt+C'. To paste, highlight the desired text and press 
'Ctrl+Alt+V'.  

If you're applying styles in the draft view, you do not need to highlight the text to copy and paste 
styles. You can simply click the text, copy the style, click the text to be styled, and then paste!  
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2.5 Inserting Symbols  

If you need to add a table or a figure to your Amendment, XML requires that you use an 'Em' dash in the 
title. This is simply a long dash and is found under the 'symbols' function in Word. Go to the 'Insert' tab 
across the top ribbon, and select 'Symbol' and then 'More symbols' (see Figure 5).  

When you use each symbol, it'll appear in the 'Recently used symbols' row at the bottom of the window 
in Figure X. You can also set up a keyboard shortcut key if you regularly have a lot of tables and figures.  

 

Figure 5  Em Dash 

Inserting symbols this way is a better alternative to using the equation builder, too. See Clause 6.3 for 
additional guidance on formulae. 
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3 Front Matter 

3.1 European foreword 

3.1.1 Template information 

The European foreword is an obligatory element. Its placement in the Simple Template is fixed: after 
the table of contents but before the Introduction/Clause 1.  

The Simple Template contains the correct template text for the foreword. The black text shall remain, as 
this is official template text. The red text is editable. Certain components in the foreword can be deleted, 
however.   

1. This document (EN XXXX:XXXX/prAX:XXXX) has been prepared by Technical Committee 
CEN/TC XXX “Title”, the secretariat of which is held by XXX. 

2. This document is currently submitted to the CEN Enquiry. 

3. This document has been prepared under a Standardization Request given to CEN by the 
European Commission and the European Free Trade Association, and supports essential 
requirements of EU Directive(s) / Regulation(s). 

4. For relationship with EU Directive(s) / Regulation(s), see informative Annex ZA, ZB, ZC or ZD, 
which is an integral part of this document. 

Point 1 above is obligatory text. The 'X' elements in red, i.e. the document reference, TC number, Title 
and Secretariat, are editable.  
NOTE In some cases, it is possible you do not have a reference yet. If this is the case, leave the text as it is.  

Point 2 describes the stage the text is at. This is the official template text. If you are drafting an EN, keep 
the first option. For a Technical Specification or Technical Report, choose the second or third option.  

Points 3 and 4 are only applicable to deliverables which are harmonized. If your deliverable is not 
harmonized, this text shall be deleted.  

In the case of revisions, where the publication text of the previous edition has been used, anything 
outside the scope of this clause shall be deleted.  

3.1.2 Styling the European foreword 

The European foreword has its own special styles which are only used for the foreword.  

• Title: 'Foreword Title' 

• Text: 'Foreword Text' 
NOTE Using 'Body text', or adapting the Heading 1 style in the foreword will generate XML errors.  
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4 Main Body  

4.1 General 

The main body of the text comprises the changes to be made to the existing publication. Since it is 
effectively a list of instructions, there is specific wording to follow. 

Instructions should be drafted as clearly and concisely as possible, and shall include only the aspects to 
be changed, rather than replacing entire paragraphs – but more detail is given on this later in the 
document. 

4.2 Drafting the headings 

Headings define the clause in the existing publication to be changed. They shall be drafted in 
chronological order, as you go through the existing publication.  

Headings shall be drafted as follows:  

1 Modification to clause X, 'title of clause X' 

2 Addition of clause X, 'title of clause X' 

3 Deletion of clause X, 'title of clause X'.  

It is highly unlikely that Headings 2 and above will ever be needed within an amendment.  

Styling for headings 

• Title: Heading 1 

4.3 Drafting the instructions 

4.3.1 General 

The instructions have to be written clearly and concisely, since the final publication text will be 
consolidated, and it's easy to introduce errors to the text if the instructions are lengthy and confusing. 
To avoid this, keep it short, simple and to the point.  

4.3.2 Wording  

The following wording shall be used for all instructions: 

• Add.. 

• Delete… 

• Replace… 

These are generally the only actions to be taken within an amendment.  

Then, a little detail can be added. We need to know where the text needs to be changed, and what 
needs to be changed: 

• In clause 4.2, at the end of the third paragraph, add "and 15 mm circumference." 

• In clause 6, delete the fourth paragraph. 

• In clause 10, replace "16 mm" with "18 mm". 

Only the changes to be made need to be written out, so keep things as short and concise as possible.  

Do not replace the entire clause if only one or two small elements have been changed.  
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Do not replace entire sentences if only one or two words have changed.  

Additionally, be mindful of the final consolidation that takes place at Publication stage. This 
consolidation involves tagging, which can get very messy if there are many, many tags within one 
sentence, for example. However, it also has to be clear which parts have changed, so replacing entire 
clauses is advised against, where possible.  

 

5 Main Body – Generic Clauses 

5.1 General 

Since amendments are not conventional European deliverables, they do not need to follow the same 
rules in terms of structure. This means that Clauses 1, 2 and 3 are not obligatory as the Scope, 
Normative references, and Terms and Definitions respectively. You simply start with the first clause to 
be changed.  

A best practice is to structure the amendment in such a way that the first clause modified by the 
amendment is the first clause mentioned in the amendment, and then introduce each change 
sequentially. For example, if changes are required in clauses 4, 9, 10 and Annex B, be sure to introduce 
each change in that order. Don't start with the changes in Annex B, and then clause 4, then clause 9 and 
so on.  

Note that amendments do have to follow the Internal Regulations Part 3:2022, so be mindful that the 
changes you're making follow that.  

Where any modifications that introduce new normatively referenced texts are involved, it is important 
to have a clause in the amendment modifying the Clause 2, Normative references. This also applies for 
any informative references which need to go into the bibliography. 

Finally, be mindful that CEN Amendments are consolidated by the CEN editor at the publication stage. 
For this reason, the instructions should be as clear and concise as possible, taking into account the 
tagging of the text using the Amendment Arrows. Keeping this in mind when drafting your instructions 
should make it clear when to introduce the replacement of an entire paragraph, versus the replacement 
of just one or two words.  

5.2 Clauses  

5.2.1 Simple Styling 

The styling for clauses is simple.  

• Headings  

o Heading 1, Heading 2, Heading 3 

NOTE Try not to use any heading style greater than Heading 6, to keep citations simple.  

o p1, p2, p3 (for numbered paragraphs) 

• Plain paragraphs 

o Body text, Body text Indent 

• Lists 

o List continue 1, List continue 2 (for bullet or dashed lists) 

o List number 1, List number 2 (for numbered/alphabetised lists) 
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• Formulae 

o Formula  

o Body text (for the word 'where' which precedes any explanations) 

o Table body (for explanations, which are contained in a table)  

5.2.2 Special cases 

As an amendment doesn't follow the regular structure, the styling of certain elements is a little different 
to compensate for this irregularity – there's a bit more freedom, specifically regarding normative 
references, and terms and definitions.  

Normative References: 

These can be styled as Body text, and formatted conventionally using italic for the title of the reference. 
The RefNorm style is also acceptable, but not obligatory.  

Terms and Definitions: 

These can also be styled as Body text, and formatted conventionally using bold for the term number and 
term. The TermNum, Term and Definition styles can also be used, but are not obligatory. Do not use the 
style 'Heading 2' for term number.  

In addition, please do not use soft returns to adjust the spacing between the term number and term! 
These have to be removed manually by the editors, as soft returns mean each line separated by a soft 
return is treated as one whole paragraph. Instead, use hard returns, and either leave the spacing fix to 
your editor, or use the drop-down menu under 'Paragraph' on the Home Tab on the top ribbon to alter 
spacing (see Figure X).  
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Figure X  Adjusting the space between paragraphs 

 

5.3 Tables  

Tables are used to lay out information in a clear and concise way. In an amendment, it is sufficient to 
only mention the cell and row to be changed:  

In Table 3, column 3, row 5, replace …  

In Table 8, delete row 6.  

In Table A.1, add the following new row after row 7: 

Data from 2022 5 9,6 58 

Tables shall be simply drafted. If you need to merge cells, do so at the very end of drafting, otherwise 
cells can become corrupted, which can lead to tricky errors when the CEN Editor creates the XML 
version of the text.  
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Any new/whole tables added shall have at least the following components:  

• Clear number designation (e.g. Table 1), with an optional concise title 

• A clearly defined header (making the header bold is an easy way to do this) 

• Simply-drafted content.  

Tables may also include:  

• Footnotes  

• Notes  

• Figures/formulae in cells  

• Dimensions 

Tables can break across multiple pages. If this is the case, simply repeat the header row. To do this, 
highlight the header row(s) and choose the layout tab from the top ribbon in Word. Then, click 'Repeat 
Header Rows', and this will repeat the row selected across the top of each page. 

Do not use nested tables, i.e. a table within a cell. These are systematically removed by the editor, as 
XML does not support them. This can however be time-consuming, so please don't do it!  

Additional things to avoid when drafting tables:  

• White text on black backgrounds (XML does not support white text) 

• Coloured text on coloured backgrounds 

• Vertical text  

 

Example of a perfect table:  

Table 1  A perfectly drafted table  
Dimensions in millimetres 

 Table header 
Additional header info 

Clearly-defined 

Table content  Table content with footnotea - 

Table content  - - 
NOTE  This is a table note. It follows the same rules as a regular main body note. 
a A footnote to the table. The callout above is superscript OR raised. The callout in 
this cell is also superscript OR raised. 

 

Styling for tables:  

• Title: Table title  

• Dimensions: Dimension_100 

• Header (all header rows): Table header  

• Table content: Table Body  

• Footnotes: Table Footer  

• NOTES to tables: Table Footer Note 
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In some cases, you may need to reduce the font size of the text in your table. In such cases, use:  

• Header: Table header (-) for 10pt; Table header (--) for 9pt 

• Table content: Table Body (-) for 10pt; Table Body (--) for 9pt 

Where only a single row is added 

• Table Body  

 

5.4 Figures 

Figures are used to display information more concisely, in the form of a diagram, for example.  

If a figure needs to be modified, only the modified element needs to be noted. For example, if only the 
key needs to be modified, only that element shall be described in the instructions. Or, if only one 
subfigure needs to be updated, it is enough to just insert the new subfigure.  

If a whole figure needs to be replaced, only that figure file needs to be provided – it is not necessary to 
send in every single figure file found in the mother standard, since CCMC retains copies of all figure files 
with the mother standard.  

Figures shall be language-neutral; this means no text can be contained therein. There are some 
exceptions to this rule. See the Preparation and Submission of Files on the CEN BOSS for detailed 
information and technical requirements.  

Figures shall contain at least a figure image and a figure number designation (e.g. Figure 1, Figure 2, 
Figure A.1, Figure B.2), and preferably an optional title.  

Figures may also contain:  

• Dimensions  

• Notes 

• Text 

• Key and explanations  

• Subfigures and a letter designation (e.g. a), b), c)).  

Figures shall be laid out as follows:  

https://boss.cen.eu/reference-material/guidancedoc/pages/prepfiles/
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Dimensions in millimetres 

 
Key 

1 key content (hide the borders) 

2 key content (hide the borders) 

Figure 7  Title of figure 

For subfigures, the principle is the same, except that subfigure titles are styled 'Figure Subtitle' 
instead. The subfigure designation shall be simply 'a), b), c)', with an optional title.  

For all subfigures in the same figure, only one key shall be provided. See the example below, which 
shows how to lay this out.  
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a) 

 

b) 
Key 

1 key content (hide the borders) 

2 key content (hide the borders) 

NOTE  Figure note content 

Figure text content 

Figure 8  Title of figure 
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Styling for figures:  

• Figure/subfigure: Figure Image 

• Dimensions: Dimension_100 

• Notes to figures: Figure Note 

• Supplementary figure text: Figure Text 

• Key title: Key title  

• Key content: Key text (and laid out in a table with borders hidden) 

• Title (and subfigure title): Figure title 

5.5 Formulae 

Formulae are a simple way to display any calculations that are indispensable for the use of the 
document.  

As with other elements which need to be modified, if only a small portion of the formula needs to be 
modified, it is sufficient to describe only that portion. However, to avoid introducing errors, it is a good 
idea to also write out the whole formula correctly too, so the editor knows what to do when it comes to 
consolidation at publication stage.  

CEN Editors strongly recommend the use of MathType (a paid software add-in for Word), especially if 
you have a huge number of formulae across a large number of standards. However, if MathType isn't 
available, Word has useful tools to help.  

If you have a simple formula, it is better to use the keyboard to type it out as plain text. Symbols like +, - 
and = are generic characters and fully supported by XML. Additional symbols, for example any Greek or 
mathematical symbols, can be found using the 'Symbol' function in Word (the same place you go to for 
the Em dash).  

For more complex formulae, however, you may use the Equation Builder in Word. In the 'Insert' tab 
across the top ribbon, there is the option beside 'Symbol', called 'Equation'. Click this, and it'll insert a 
blank formula. From there, simply type in the information you need! See Figure 9.  

For the layout, please only rely on the style given at the end of this subclause to lay the formula out 
properly, especially if you choose to number the formula. Do not lay the formula out using a table. 
These have to be manually removed by the CEN Editor, which is time-consuming.  

When numbering a formula, type out your formula with the desired method, and then insert a tab using 
the keyboard. Then, write your number between parentheses. Once you apply the style, the number will 
jump across to the right side of the screen, leaving your formula on the left.  
NOTE If the styling does not work as described, please leave it as it is and your CEN Editor will correct it.  

 

 

Figure 9  Using the Equation Builder 
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Styling for formulae:  

• Formula: Formula 

 

5.6 Annexes 

Annexes are found after the main body of the text. They follow the same rules as the main body of the 
text, but the styling of the heading elements is a little different, especially since the ANNEX heading 
usually puts the Annex designation and title on the next page. This means that some additional work 
might be needed to improve the layout.  

Styling for general annexes:  

• Main Annex title 

o ANNEX  

o Body text, plus conventional formatting (bold, increase font size to 14pt, and centre-
justify) in the event that the ANNEX style doesn't work. 

• Annex clause headings: a2, a3, a4 
NOTE Annex clause headings start from heading 2 because of the letter at the beginning (e.g. A.1, B.2).  

Styling for Annex ZA:  

• Main Annex title: ANNEX Z 

• Annex clause headings: za2, za3 

• 'WARNING': Notice 

If only one clause needs to be modified, headings a2 and so on will generate XML errors. So, it is 
acceptable and in fact better to use Body Text, and adjust the size of the font and make it bold. 

Modifications should follow the same rules as the modifications to any clauses in the main body of the 
text, i.e. if only one clause needs to be modified, modify only that clause.  

The whole annex should only be inserted if:  

• It is the addition of a whole new annex; or 

• If a significant portion of the annex has been rewritten.  

If only one or two modifications have been made, then only refer to those subclauses/paragraphs.  

 

5.7 Bibliography  

The bibliography is the final element of the text and is informative. It contains all the references that 
aren't mentioned normatively in the text, alongside anything else you want the user of the deliverable 
to access, too.  

Bibliographic entries can be either numbered or un-numbered. Numbering is useful if you want to refer 
to a reference in the text. To number a bibliographic reference, use square brackets, and a tab:  

[1] tab EN XXXX-X, Title 

There is no need to title the bibliography at all. The clause title 'Modification to the Bibliography' is 
sufficient.  
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Styling for Bibliography:  

• References: Biblio Entry 

• Descriptions/Headings: Biblio Description 

5.8 Code  

Where lines of code are needed, these can be drafted normally as plain text. The code style uses the 
'Courier New' font, which is acceptable and supported by XML. If you don't want your code to be in 
Courier New, you can simply style it as 'Code' and then highlight the text and change the font back.  

Be mindful here of the changes required to any code. It can be difficult to introduce changes to single 
lines of code, so do try to be as clear as possible where the change is to take place. This can be done 
with a simple demonstration.  

Styling for Code:  

• Code lines: Code OR Body text and change the font to Courier New 

6 Finishing touches 

6.1 Introduction 

Once you've finished drafting the text, there are a few key things to handle before creating a final clean 
PDF file, and submitting the text package to CCMC. Headers and footers are a required element of the 
text, so do ensure they're both present.  

6.2 Headers and footers 

6.2.1 Headers 

In the headers, you need to add the reference of the text (if you have it), the year of the text, and the 
language. It shall be laid out as follows:  

EN XXXX:YYYY/prAX:YYYY (E) 

For Enquiry drafts, the reference is always 'prAX'.  

For Formal Votes, the reference is always 'FprAX'.  

The year is always the year in which the text will be launched to the ballot – NOT the year it is 
submitted.  

The language is 'E' for English, 'F' for French and 'D' for German.  

For new work, it is possible (and probable) that you won't have a reference for the text yet, in which 
case it can be left as prEN XXXX. The CEN Editor will add the reference in when they edit the text.  

6.2.2 Footers 

Footers always contain the page numbers. They shall be left or right-justified, depending on the page 
number (see clause 7.2.3). Only the number itself is necessary; there is no need to add 'page' or 
anything else.  

6.2.3 Justification of headers and footers 

Even-numbered pages shall be left-justified. Odd-numbered pages shall be right-justified. Ensure that 
the justification is continuous after any page-breaks or page-orientation changes.  
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6.3 Table of Contents 

Do you use the table of contents as an overview of the document while drafting? Do you regularly meet 
problems with it corrupting, or not updating? An easier way to see an overview of your text is to use the 
Navigation bar on the left-hand side of the screen. The Navigation bar allows you to see all the headings 
(including tables and figures) that are present in the document – you can even hide entire 
clauses/subclauses by using the small arrow at the side.  

To create the Table of Contents from scratch:  

Once you've finished drafting, however, the table of contents will need to be updated. It is also an 
obligatory element, coming before the European Foreword and after the Title Page.  

The Table of Contents shall start with the word 'Contents' justified to the left, and 'Page' in smaller font 
to the right. As a rule, 'Contents' is font size 14 and bold, and 'Page' is font size 11 and not bold.  

 
a) 

 
b) 

Figure 10  Table of Contents header 

Add a hard return after the word 'Page'. Go to the ribbon across the top of Word and choose the 
'References' tab  'Table of Contents'  'Custom Table of Contents'. 
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Figure 11 

Click this, and a dialogue box will appear. Click 'Options'.  



CEN Amendment Simple Template — Quick Start Guide 

23 

 

 
Figure 12 

You will then be presented with a list of elements to be included in the Table of Contents. Pay attention 
to the number of subclauses you have; a large number of subclauses will create a longer Table of 
Contents, which can needlessly increase the overall page count of the document.  

As a rule, the following elements should be included in the Table of Contents:  

 ANNEX (and ANNEX Z if your text is harmonized) 
 Biblio Title 
 Foreword Title 
 Headings 1, 2 and 3 (or just headings 1/2 if there are a lot of subclauses) 
 Intro Title 

To add these elements, in the dialogue box, click 'Reset'. This will remove any unnecessary elements 
from the list. Then, after each of the headings in the list above, add a number 1 in the corresponding 
boxes, except for Headings 2 and 3, which need a 2 and 3 respectively (see Figure 13).  
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Figure 13 

Once all the elements are added, click 'OK' and then again, and the Table of Contents will appear. From 
there, any modifications you bring to the text can be included simply by right-clicking anywhere on the 
Table of Contents, and clicking 'Update Entire Table'.  

To replace an existing Table of Contents 

Highlight the existing Table of Contents, and then follow the same steps outlined above. The only 
difference is that, when you click OK in the dialogue box shown in Figure 13, you will be asked if you'd 
like to replace the selected Table of Contents. Click 'OK', and the new Table will appear.  

 
Figure 14 

6.4 Creating the PDF 

The final clean PDF file can be generated either using the Adobe Acrobat extension in Word (if you have 
that software installed), or by saving the Word document as a PDF (Save As  PDF file).  
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Annex A 
(informative) 

 
Useful Information Sources 

A.1 General 

In addition to this Quick-Start Guide, CEN offers plenty of drafting guidance and help to make sure that 
your deliverable is of the highest-quality. If you're stuck on any of the drafting elements, you can access 
any of the resources outlined in this annex.  

A.2 Webinars  

The CEN editors regularly give webinars tailored to drafting. These webinars are usually in-depth on 
any specific drafting element and come with a YouTube recording and a PDF of the presentation, as well 
as a Q&A sheet containing audience questions, and responses from the editors.  

The most up-to-date webinars are from 2020.  

Webinars for Standards Drafters from 2020.  

In addition, there is a dedicated webinar for the regular Simple Template, including a live 
demonstration of it. It is the same principle as Amendment template: 

Webinar for Standards Drafters – Simple Template Quick Start and Drafting Guidance.  

A.3 Internal Regulations Part 3 

The Internal Regulations Part 3 (IR-3) is the standard for standards. The rules outlined in the IR-3 are 
closely followed by the editors, and are used in every webinar – even in this document, too! It is worth 
keeping a bookmark in your preferred web browser with a direct link to the IR-3, so that you can 
ensure you have the latest rules for drafting at your fingertips.  

Internal Regulations Part 3. 

A.4 Still stuck? 

If you still need help, you have some options:  

1. Contact Mail Production  

If you do not have an editor already allocated to a text (for example, you're starting new work or 
you haven't yet submitted anything), then you can contact production@cencenelec.eu and a 
colleague will happily pass on your question to an editor.  

2. Contact your CCMC contact point  

This information is found on ProjexOnline. Usually, it is the editor allocated to your document. 
However, you can also contact the Technical Sectoral PM, and they will be able to guide you to 
an editor for help.  

Editors can also be present at your meetings, too! We can offer live help either in person, should you be 
present in the Management Centre, or via Zoom or Teams. Just ask!  

https://experts.cen.eu/trainings-materials/events/?datefilter=PERIOD&Types%5B%5D=8553&Categories%5B%5D=8557&past=1&tags%5B%5D=&page=1
https://experts.cen.eu/trainings-materials/events/2021/2021-12-02-webinar-simple-template/
https://boss.cen.eu/reference-material/refdocs/pages/
mailto:production@cencenelec.eu
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Annex B 
(Informative) 

 
Useful Keyboard Shortcuts 

When drafting your document, lots of mouse-clicking can become quite tedious. Table B.1 contains a list 
of common keyboard shortcuts you might find useful while drafting.  
NOTE Additional keyboard shortcuts within MS Word can be researched online. 

Table B.1  Common keyboard shortcuts 

Keyboard Shortcut What does it do? 

Ctrl+A 
Ctrl+C 
Ctrl+V 

Selects all text in the document 
Copies all selected text to clipboard 
Pastes all text copied to clipboard 

Ctrl+arrow keys Jumps the cursor along entire words 

Ctrl+Shift+arrow keys Highlights entire words/sentences, as well as entire table 
cells/rows 

Ctrl+Shift+C 
Ctrl+Shift+V 

Copies style of highlighted paragraph 
Pastes style of highlighted paragraph 

Ctrl+Alt+n Used to enter draft view, to see the styling pane and styles 
behind each paragraph 

Ctrl+Z 
Ctrl+Y 

Used to undo the previous action (typing/styling) 
Used to redo the previous action if it was undone accidentally 

Ctrl+d Opens up the font dialogue box (for advanced font settings – e.g. 
raised/lowered super/subscripts) 

Esc Exit dialogue boxes 

Alt + underlined letters 
e.g. Alt+F 

Completes the action described by the underlined letter (e.g. 
save, cancel…) 

Tab key/arrow keys Can be used to scroll through menus  
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